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IBM Rational Build Forge What's New
This guide lists new features and known issues, including workarounds for the issues where
possible.

Before using this information be sure to read the general information under “Notices” on page 16

First Edition October 2008

This edition applies to IBM® Rational® Build Forge® 7.0.2.

Document version and build: 7.0.2-003.0006.

© Copyright International Business Machines Corporation 2003, 2008. All rights reserved.

US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA ADP
Schedule Contract with IBM Corp.
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About the Release
This document provides information about enhancements, resolved problems, and known issues
in version 7.0.2 iFix3 of the Build Forge product.

Installing this release
Before installing this release, obtain the latest version of the IBM Rational Build Forge Installation
Guide.

Express Edition users can use the IBM Rational Build Forge Express Installation Guide.

The installation guide provides detailed instructions for installing the product and upgrading from
previous versions.

Important updates include information related to national language support, prerequisite software,
and supported platforms and databases. Review the information in the installation guide before
starting an installation or upgrade.

Getting the latest release notes
Important updates to this document may have been made since it was prepared for the product
release. Download the updated edition from the IBM Publications Center, as follows:

1. Go to http://www.ibm.com/shop/publications/order.

2. Click Search for Publications.

3. In the Publications number field, enter the document number from the title page of this
document.
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New and Updated Features
No new or updated features are included in 7.0.2 iFix3.
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Fixed in This Version
This section lists problems that have been fixed in the current release. They are identified by their
APAR defect tracking numbers.

The Description text is copied directly from the internal tracking database (RATLC) and may contain
spelling or grammatical errors.

Adaptors

Internal RATLCHeadlineAPAR

RATLC01064918adaptor does not return subject and body of email within debug modePK66471

Agent

Internal RATLCDescriptionAPAR

RATLC01264647agent fails when root is set to c:\PK70870

RATLC01262916Agent 7.0.2-ifix2 source kit fails to compile on non-ipv6 OSPK70143

RATLC01234983Job Cancel action in Console creates stranded processPK70089

RATLC01261376
Using nmap opens bfagent processes which don't close and use
100% CPUPK69465

RATLC01260554The .source env variable is not working with the iFix 2 agentsPK69175

RATLC01066091tmp files not cleaned up after dot commands .bset and .retagPK67083

RATLC010644227.0.2-ifix1 agent returns disconnect for engines prior to 7.0.2PK66247

RATLC01229397
CPU_LOAD incorrectly calculates when evaluating dual core Xeon
processorsPK65722

RATLC01061733Windows user logoff will stop running build running as a 'service'PK65049

API

Internal RATLCDescriptionAPAR

RATLC01065740Long periods of inactivity using the API cause an error using MySQLPK66942

RATLC01064773
The Java API does not allow updates for a users datefmt if the date
format is blankPK66412

RATLC01063689Java Client: AccessGroup.getLdapDN returns null stringPK65967

RATLC01058046Build Forge addStep() method does not update Project objectPK63469
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Documentation

Internal RATLCDescriptionAPAR

RATLC01262572DOC Switch to User needs to be documentedPK69972

RATLC01259111.put command is overwriting previous records without warningPK68763

RATLC01068925Documentation on Semaphores in the online help is incorrectPK68247

RATLC01065092
KNOWN ISSUE: when using pvcs commands, make sure the
disable_transcode option is uncommented in the bfagent.confPK66530

RATLC01064925adaptor <adduser> tag only works within the <interface> blockPK66472

RATLC01040223
DOC install guide should list priv needed for windows user mode
agentPK55452

IDE Plug-ins

Internal RATLCDescriptionAPAR

RATLC01258712
Defect: BF 7.0.2: Running projects containing a lot of files or big files
fail in the RAD/BF integrationPK68631

Management Console Engine

Internal RATLCDescriptionAPAR

RATLC01268899
$TAILNORMALLOG, $STEPNORMALLOG expand to blank in notify
emailPK72846

RATLC01267950The CQ Perl scripts in the integration directory are hex encodedPK72494

RATLC01062387Environments are not composed correctly (regression)PK71070

RATLC01264613
BuildForge trying to update database column with string rather than
single characterPK70848

RATLC01261713
The sync command option fails for steps which use the newer 64-nbit
UUID formatPK69580

RATLC01261236A filter added to a project using the Include feature is not exportedPK69422

RATLC01259162
Pass chains from the project level incorrectly make some BF variables
BF_CALLER_CALLERPK68782

RATLC01258576
Broadcast threaded step fails to complete if one of the steps which
are threaded fails.PK68572

RATLC01069353.pop only returns 8k of project registersPK68384

RATLC01068840
A server with a false active available status will prevent manifests
refreshesPK68212

RATLC01068635
Microsoft Exchange Server cannot handle the email header sent out
when there are over 17 recipientsPK68153
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Internal RATLCDescriptionAPAR

RATLC01068317
In-line serial steps called from threaded steps wait for the parent level
threaded steps to complete.PK68077

RATLC01067977sticky chooses wrong server if first step has its own selector definedPK67915

RATLC01067780
Importing projects with step names beginning in numbers causes
steps to be uneditable until name is changedPK67806

RATLC01067621
Pass notifies are sent out when a step fails and is set to continue on
failPK67727

RATLC01067115Environment variables are not properly rebuilt after restartPK67549

RATLC01231092.export fails for some projects only when agent tracing is offPK66855

RATLC01065414Intermittent delay between serial step executions - 30mins to 2hrsPK66702

RATLC01063570class start on entry not exported by bfexportPK65934

RATLC01229580Clustered engines cause purge conflicts and error notificationsPK65921

RATLC01229129Importing project fails to set correct selector for a step.PK65570

RATLC01062276The bfexport process exports the same environment twicePK65278

RATLC01060945Cannot use a dot in an environment variablePK65122

RATLC01060934
Build Forge does not correctly roll back the build tag on a failed
adaptor link buildPK64658

RATLC01059914
The bfproject.pl process continues after the buildforge stop command
is issued.PK64321

RATLC01049849Build Forge upgrade to 7.0.2 breaks existing CQ integrationPK60105

Management Console User Interface

Internal RATLCDescriptionAPAR

RATLC01264579
When creating a new access group, the user cannot immediately edit
it and must go through rootPK70844

RATLC01235988Not all filters are available from the drop-down menuPK70794

RATLC01263499
Environment lists made up of variables making use of the new Expand
Env Var option do not honor must change settingPK70381

RATLC01263047Must Change environment variables are not being highlighted in redPK70210

RATLC01261112
An environment ariable made up of a list of variables do not substitute
properlyPK69363

RATLC01233988BF: Right pane is missing when printing from IE 7PK69246

RATLC01259301
The collector query for MySQL pulls out duplicate rows using the
DISTINCT operatorPK68837

RATLC01068278quickReport flyouts display transparent in IEPK68066

RATLC01068119Step thread icon does not translate the tool tip properlyPK67975
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Internal RATLCDescriptionAPAR

RATLC01067215
BF 7.0.2: Time Zones - job report/step logs times are ignoring Daylight
Saving TimePK67590

RATLC01231334
Users without permission to change environment variables can still
do so by clicking 'Save Environment' when running projectsPK67085

RATLC01065219
Restarting a build with must change variables on SQL Server results
in no cursor errorPK66578

RATLC01063682New LDAP users do not have the date format entered in the DBPK65960

RATLC01063269
The user interface always displays GMT for long format regardless
of a user's localePK65787

RATLC01061675
QR performance rep should list adapter link step seperately instead
of adding duration to first step run timePK65048

Quick Reports

Internal RATLCDescriptionAPAR

RATLC01068278quickReport flyouts display transparent in IEPK68066

RATLC01061675
QR performance rep should list adapter link step seperately instead
of adding duration to first step run timePK65048
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Known Issues
This section describes issues that remain open in this release at production time.

Output from pvcs commands not captured by agent
on AIX
A step containing a pvcs command may not capture all of the expected output if it is run by an
agent on AIX.

Workaround:

Uncomment disable_transcode in bfagent.conf for the agent.

DISK_FREE not updated in Manifest tab for a server
(Windows)
On Windows systems, the DISK_FREE property is not updated in the Manifest tab after clicking
Test Connection or clicking Refresh on the manifest tab. In the Management Console, click
Servers , then click an individual server, then click the Manifest tab. The DISK_FREE property
appears in the properties displayed if it was defined for the server. If the free disk space on the
server changes, then clicking Test Connection or Refresh should cause the value to be updated.

Workaround:

Click on a tab other than Manifest for the server, then click Manifest again.

Files not copied when using Eclipse reflector
Issue: a selected file is not copied over.

Workaround:

When selecting files, select all directories from the root to the file location in addition to the file
itself.

For example, if you want to reflect the file APIException.pm and it is located in the path
perl/BuildForge/Ex, you must check all of these names in the file tree:

• perl

• BuildForge

• Ex

• APIException.pm
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If you check APIException.pm but do not check its parent directories up to the root, then the file is
not copied.

Cannot connect to Microsoft SQL Server database if
a case-sensitive collation is used
If a Build Forge database on Microsoft SQL Server is created using a case-sensitive collation,
Build Forge fails during startup with the following error:

C:\Program Files\BuildForge>BuildForge -d
DBD::ODBC::st execute failed: [Microsoft][ODBC SQL Server Driver][SQL Server]Invalid object
 name 'information_schema.tables'. (SQL-42S02)
[Microsoft][ODBC SQL Server Driver][SQL Server]Statement(s) could not be prepared. 
(SQL-42000)(DBD: st_execute/SQLExecute err=-1) at /PerlApp/BuildForge/DB/Handle.pm line 
211.

8808 /PerlApp/BuildForge/DB/sqlserver.pm(BuildForge::DB::sqlserver):42

8808 /PerlApp/BuildForge/DB/Handle.pm(BuildForge::DB::Handle):413

8808 /PerlApp/BuildForge/DB/ConnectionHandler.pm(BuildForge::DB::ConnectionHandler):34

Workaround: use a case-insensitive collation, such as the default: SQL_Latin1_General_CP1_CI_AS.

Build Forge on Solaris hangs if file descriptor limit
is set higher than 1023
Build Forge on Solaris can hang while trying to acquire a license due to a known issue in the
Rational License Server.

To determine the file descriptor limit, use the following command:

ulimit -n

Workaround: set the file descriptor limit to 1023 or lower. If you do this while Build Forge is hanging,
the license server corrects itself and Build Forge acquires a license immediately.

Environments: backslash before ending quote in a
variable assignment does not yield expected result
In a variable assignment (.bset env) there are unexpected results if the last character before the
ending quote is a backslash. This true even if preparsing is turned off
(_NO_PREPARSE_COMMAND is true). Example from step execution log:

195 01/28/08 03:45PM STEP .bset env "VAR07=C:\"
196 01/28/08 03:46PM EXEC .bset env 'VAR07' = ''

Workaround: put a space before the ending quote. Example from step execution log:

187 01/28/08 03:45PM STEP .bset env "VAR032=C:\ "
188 01/28/08 03:45PM EXEC .bset env 'VAR032' = 'C:\'
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URL for version 7.0 notification templates might not
work in later versions
The notification template URL provides a link in the notification e-mail to the build report in Build
Forge.

In version 7.0.1, the URL in the notification templates changed. Consequently, when you upgrade
from 7.0 to any later version, the notification template URL links might not work.

If you experience a link error, make the following changes to the notification templates:

1. Select Project > Templates.

2. Click on the notification template to display its properties on the Details tab.

3. In the Body field, locate the URL for the template. The URL should be similar to the one in
the following example:

http://${CONSOLEHOST}:${CONSOLEPORT}/fullcontrol/index.php?mod=projectruns&action=
edit&bfid=${PID}&bfid=${BID}&bfid=${UID}

4. Replace the following 7.0 URL elements with the appropriate 7.0.1 (and later) URL elements:

7.0.1 (and later) URL elements7.0 URL elements

jobsprojectruns

&&amp;

IE6 generates Visual C++ runtime error on save of
data
Internet Explorer 6 users may see a Visual C++ runtime error if the Google toolbar is installed.

As a workaround, in IE go to Tools > Internet Options > Advanced and the uncheck the "Enable
third party browser extensions" option.

Build Forge System i agents need to change standard
agent port (5555)
The standard Build Forge agent port (5555) may be preassigned on a System i server. In this
case, change the Build Forge agent port to an unassigned port before starting the agent. You can
edit the BFagent.conf file directly or use another method to change the port. For details, see the
installation guide.

This problem will be fixed in a future release of the product.
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Duplicate column values not displayed in Quick
Report wizard-generated reports
In wizard-generated reports, column values are not displayed if they duplicate or match the column
value of the previous record. This display convention makes it look like report data is missing when
it is not.

This problem is due to a limitation in the Eclipse reporting tool, BIRT. In a future product release,
the ability to hide or display duplicate column data will be provided.

Some tool tip messages in system configuration
settings are truncated
This display problem is due to a limitation in Mozilla Firefox. Presently, there is no workaround.
The problem will be addressed in a future product release.

Quick Report titles in performance report may be
truncated
Because of a dynamic chart sizing issue in the current version of the Eclipse reporting tool BIRT,
performance report titles may be truncated. Presently, there is no workaround. The problem will
be addressed in a future product release.

Quick Report titles cannot contain periods
When you create a report, you must specify a title. If your report title contains a period, an error
is generated and the report is not created.

Do not include periods in your report titles.

Not all installed components run if the Management
Console is installed to NLV path
Do not use national language characters in the installation directory path name that you specify
for the Management Console. Problems with the installer prevent Build Forge from installing
correctly. Use US-ASCII characters only for the installation directory path. This problem will be
addressed in a future product release.
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Output for Build Forge agent install script (install.sh)
is English-only
If you install the Build Forge agent on a host with an operating system language other than English,
for example French on AIX, the output from the install script is in English. This issue will be
addressed in a future product release.

Install panels for MS Visual Studio .NET for Build
Forge are English-only
The installation panels for installing and setting up MS Visual Studio .NET 2005 for Build Forge
are not internationalized. The panel text is English only.

DB2 error when upgrading from version 3.8 on MySQL
to 7.0.2 on DB2 Express
If you migrate from version 3.8 with MySQL database to version 7.0.2 with DB2 Express, you run
the bfdbmigrate script to migrate the database.

When you restart the Build Forge engine, the migrated database is started up. You might see a
DB2 ALTER TABLE error.

Ignore the DB2 ALTER TABLE error; it is caused by an error in the Build Forge upgrade procedure.
The upgrade procedure will be deprecated in a future release of the product.

Workaround: migrate to version 7.0 or 7.0.1, then migrate version 7.0.2.

Oracle 9.x database fails with ORA-01400 error
The following error occurs only if the Management Console is using an Oracle 9.x database, the
DBD::Oracle driver, and the ora_ph_type parameter is set to a value that strips trailing blanks.

DBD::Oracle::st execute failed: ORA-01400: cannot insert NULL 
into("BLDFORGE"."BF_RESULT"."BF_ENV")

To fix the error, do the following:

Set the ora_ph_type parameter. The value for ora_ph_type in <bf-install>/db.ini must be set to a
value that does not cause the driver to strip trailing blanks. The setting ora_ph_type=96 is
recommended. If set to a value that strips trailing blanks (for example, SQL_VARCHAR), you will
receive an error. The problem does not occur with Oracle 10.

Quick Report fails to start (Microsoft SQL Server and
Oracle databases)
Limitations in JDBC drivers cause the following requirements:
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• Oracle: the database name and SID must use the same value (tnsnames.ora)

• Microsoft SQLServer: in an ODBC driver, the Database Name and Data Source Name must
use the same value.

If these requirements are not met, the Quick Report reporting feature does not work. The
requirements are documented in Build Forge Installation Guide.

Management Console cannot connect to MySQL
5.0.41 database on console start (Windows only)
If Management Console fails to start and connect to the database, it might be caused by an error
in the libmysql.dll file. To determine this, open the php_error.log file located in
C:\<BF_installationdir>\Apache\logs. If the following error message is present, the error is in
libmysql.dll.

PHP Warning: PHP Startup: Unable to load dynamic
library 'C:\Program Files\BuildForge\Apache\php\ext\php_mysqli.dll' - Invalid access to 
memory location.

To fix the problem in libmysql.dll , download and copy a new version, as follows:

1. Download mysql-noinstall-5.0.41-win32.zip from the MySql Web site, for example:
http://www.mysql.org/get/Downloads/MySQL-5.0/mysql-noinstall-5.0.41-win32.zip/from/http://mirror.x10.com/mirror/mysql/

2. In the zip file, locate \mysql-5.0.41-win32\lib\debug\libmysql.dll .

3. Stop MySql.

4. Copy libmysql.dll to the <mysql_installdir>\bin directory.

5. Start MySql.

6. Restart the Management Console.

New license server ignored on upgrade
If you enter a different host name for the license server on an upgrade install than you entered
when the Management Console was first installed, the installation program ignores the new value.

Workaround:

Do not attempt to change the license server during upgrade. To change the license server once
the system is installed or upgraded, follow the instructions in the Installation Guide: Installing the
License Server > Changing the License Server to Use.

Inconsistencies in BOM display for large BOMs
If the BOM for your project is large, you may notice that the category names for a section might
not be displayed correctly.
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Assign hidden option not hiding variable value in
logs
If you select the Assign Hidden property when you create a variable, the variable value is displayed
in the step log instead of being masked with asterisk (*) characters.

Note

If you export a project, variables with the Assign Hidden property are shown in cleartext in
the exported XML file.

This problem will be fixed in a future release of the product.

Environment variable names that contain periods
If an environment variable name contains a period, attempts to reference that variable name in
another variable fail. Shell-command parsing works differently on different platforms, which makes
finding a uniform fix difficult.

Workaround on Windows platforms only:

1. Set an environment variable to the value of the variable name you want.

Name: tmp_var      Value: Version_1.1

2. Within a step, use the variable as the variable-name portion of an assignment.

set $tmp_var = 7

When the job runs, a variable Version_1.1 is created with the value 7.
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Contacting IBM Customer Support for
Rational Products
If you have questions about installing, using, or maintaining this product, contact IBM Customer
Support as follows:

The IBM software support Internet site provides you with self-help resources and electronic problem
submission. The IBM Software Support Home page for Rational products can be found at
http://www.ibm.com/software/rational/support/.

Voice Support is available to all current contract holders by dialing a telephone number in your
country (where available). For specific country phone numbers, go to
http://www.ibm.com/planetwide/.

Note

When you contact IBM Customer Support, please be prepared to supply the following
information:

• Your name, company name, ICN number, telephone number, and e-mail address

• Your operating system, version number, and any service packs or patches you have
applied

• Product name and release number

• Your PMR number (if you are following up on a previously reported problem)

Downloading the IBM Support Assistant
The IBM Support Assistant (ISA) is a locally installed serviceability workbench that makes it both
easier and simpler to resolve software product problems. ISA is a free, stand-alone application
that you download from IBM and install on any number of machines. It runs on AIX, (RedHat
Enterprise Linux® AS), HP-UX, Solaris, and Windows® platforms.

ISA includes these features:

• Federated search

• Data collection

• Problem submission

• Education roadmaps

For more information about ISA, including instructions for downloading and installing ISA and
product plug-ins, go to the ISA Software Support page.

IBM Support Assistant: http://www.ibm.com/software/support/isa/.
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Notices
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently
available in your area. Any reference to an IBM product, program, or service is not intended to
state or imply that only that IBM product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any IBM intellectual property right
may be used instead. However, it is the user's responsibility to evaluate and verify the operation
of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You
can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 
U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where
such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION
"AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow
disclaimer of express or implied warranties in certain transactions, therefore, this statement may
not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are
periodically made to the information herein; these changes will be incorporated in new editions of
the publication. IBM may make improvements and/or changes in the product(s) and/or the
program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and
do not in any manner serve as an endorsement of those Web sites. The materials at those Web
sites are not part of the materials for this IBM product and use of those Web sites is at your own
risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate
without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i)
the exchange of information between independently created programs and other programs (including
this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
Department BCF
20 Maguire Road 
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Lexington, MA 02421  
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some
cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are
provided by IBM under terms of the IBM Customer Agreement, IBM International Program License
Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore,
the results obtained in other operating environments may vary significantly. Some measurements
may have been made on development-level systems and there is no guarantee that these
measurements will be the same on generally available systems. Furthermore, some measurements
may have been estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products
and cannot confirm the accuracy of performance, compatibility or any other claims related to
non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To
illustrate them as completely as possible, the examples include the names of individuals, companies,
brands, and products. All of these names are fictitious and any similarity to the names and
addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate
programming techniques on various operating platforms. You may copy, modify, and distribute
these sample programs in any form without payment to IBM, for the purposes of developing, using,
marketing or distributing application programs conforming to the application programming interface
for the operating platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability,
serviceability, or function of these programs.

Trademarks
IBM, the IBM logo, Rational, ClearCase, ClearQuest, and DB2 are registered trademarks of
International Business Machines Corporation in the United States, other countries, or both.

Other company, product or service names may be trademarks or service marks of others.

For other IBM trademark attributions, see http://www.ibm.com/legal/copytrade.shtml
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